
Welcome to the JCT Contracts Digital Service

Rapidocs Classic + User Guide

Rapidocs Classic+ allows you to create completed JCT contracts by providing the questions for you to 
answer.

It is recommended that you begin by reading Getting Started, which explains the process of 
assembling your documents from 'intelligent' templates.

This user guide is divided into three main sections.  Clicking in each one will display all the topics 
within that section:

Managing Documents Here you learn how to use the tools provided by 
Rapidocs to enable you to effectively manage your 
documents.

Assembling Documents This section explains the process of assembling a 
document from start to finish.

Editing Documents Rapidocs provides you with a comprehensive set 
of editing tools which are explained in this section.

Alternatively, you may find it more convenient to search the index for the item you wish to find.

For more information about Rapidocs and other Rapidocs products, see About Rapidocs.



Getting Started

A Rapidocs JCT template arrives on your desktop completely ready to convert into a finished 
document.

You will be guided step-by-step through the document template, answering questions as you go 
through it.  The answers you give will be intelligently interpreted by Rapidocs, which will insert your 
answers into the document and then add, remove or alter paragraphs as appropriate.  This process is 
called assembly and is explained in Assembling Documents.  Using Rapidocs you can assemble a 
document of any complexity, yet the template remains just as easy to use - all you need to do is 
answer the questions. 

When you have finished answering the questions you will be able to edit the document using the 
powerful editing features included within Rapidocs. For information on these and also saving and 
printing your document, see Editing Documents.

The contract variables should always be completed using the question and answer session described 
in Assembling Documents. Do not type the answers directly into the document in the edit mode 
described in Editing Documents, the intelligent document assembly features of Rapidocs do not 
function in the edit mode.  

Rapidocs provides many features to help you manage your documents.  The Managing Documents 
section explains these features and helps you to optimize your working environment.



About Rapidocs

Rapidocs Classic+ is just one part of the Rapidocs product family.

Rapidocs products produce "intelligent documents" and forms.  Using the industry standard Adobe 
Acrobat PDF format, Rapidocs offers the same easy-to-use interface to reduce the problems caused 
by incomplete or inaccurate completion of forms.

Rapidocs products are continually evolving to support all aspects of document automation, including 
support for advanced server features such as document management, process management, 
workflow, and web integration.  The products and formats are specially developed for efficient use 
over the Internet, or within an Intranet environment.

For more information on the full product family, please visit our web site at www.rapidocs.com.



Getting Help

If you have queries or problems when using Rapidocs Classic+, you should speak to your local 
Rapidocs administrator in the first instance.
Failing that, you should contact the Sweet and Maxwell support line on 0845 082 1080 or by email to 
jct.support@thomson.com



Managing Documents

This section contains the following topics:

� The Navigation Window

� Base Contract Tasks
� Document Tasks

� Your Briefcase

� Rapidocs Templates and Documents
� Document Archive

� Using Rapidocs Document Properties

� Configuring Rapidocs

� Deleting Documents

� Searching for Documents

� Importing Documents

� Transfering and Exporting Documents

� Activity Report

� Hidden Documents

� Updates

� Managing Document Access



Navigation Window Overview

When you run Rapidocs Classic+ from your desktop or the 'Start' menu, the first screen you see is the 
Navigation Window.  

The window is divided into two sections; the right-hand panel lists the documents and templates in 
your Briefcase, and the left-hand panel lists Other Tasks you may wish to carry out within Rapidocs.  
The name of the selected document is shown in the top left along with the date it was last updated. 
The Description, if any, of the document currently selected is also shown.  Each of these may be 
collapsed or expanded by clicking on the chevrons at the top right of the boxes.

To select a template or document in the list use a single mouse click.

To open a template or document, use a double mouse click.

Right-clicking on the document or template will provide a menu listing tasks relevant for that 
document.



Base Contract Tasks

The Base Contracts Tasks list appears when a red JCT base template is highlighted; it contains the 
following options:

� Create a new document Opens the currently selected template or document for assembly. This 
is the same as double-clicking on it or selecting and pressing “enter”.

� Base Contract Properties This gives you access to document properties, giving you more 
information on the document. See Using Rapidocs Document Properties.



Document Tasks

The Document Tasks panel appears when a blue user document is highlighted.  It lists the following 
options:

� Open/Create Opens the currently selected template or document for assembly. This is the same 
as double-clicking on it, or selecting it and pressing 'Enter'.  

���� Email Enables you to email the selected document to a recipient of your choice (only for blue 
documents). See Sending by Email.

���� Delete Sends the currently selected document to the recycle bin.  This is the same as selecting 
the document and pressing ‘Delete’.  See Deleting Documents.

� Export Allows you to export a document to your file system (only for blue documents).  See 
Exporting to a File.

� Properties This gives you access to document properties, giving you more information on the 
document.  See Using Rapidocs Document Properties.

� Show all standard documents Display the documents marked public by others. See Document 
Access

� Mark as private Mark the selected document as private. See Document Access

� Mark as public Mark the selected document as public. See Document Access

� Clear edit lock Clear the edit lock to allow editing by others. See Document Access

� Assign ownership to someone else Give ownership of the selected document to another user 
on the network. See Document Access



Other Tasks

The Document Tasks panel (also listed as Template Tasks if a red template is highlighted) list the 
following options:

� Import Allows you to import documents or templates from your file system.  See Importing 
Documents.

� Configure Rapidocs Enables you to configure various aspects of Rapidocs.  See Configuring 
Rapidocs.

���� Change Password Not used in this version of Rapidocs Classic+. See User Password.

� Search Documents Enables you to search for a word or phrase amongst the document in your 
Briefcase.  See Search Documents.

� Activity Report Provides a printable activity report of document usage.  See Activity Report.

� Show Hidden Documents (only shown if some documents are hidden) Enables you to un-hide all 
of the hidden documents or categories in your Briefcase. See Hidden Documents.



Description

Gives a description, if appropriate, of the selected document or template and is shown in the middle of 
the left hand pane of the Navigation Window.



User Password

This is not used in the Network version of Rapidocs Classic+. The username and password for this 
version of Rapidocs is synchronised with your Windows password.
Please do not attempt to change your password using this option.



About Your Briefcase

Your Briefcase is your personal document store.  If you create new documents they will always be 
saved in your Briefcase.  You can see the contents of your Briefcase in the main area of the 
Navigation Window.  To assemble any document it must first be available in your Briefcase.

Clicking on any document once in the right hand area of the display will list the tasks available to that 
document in the left-hand Document Tasks panel.  If a document description is available, it will be 
displayed in the panel below.

Right-clicking on a document or template also provides a menu listing tasks relevant for that 
document.



Rapidocs Templates and Documents

All available Rapidocs documents are displayed in the Navigation Window.   In your Briefcase you will 
see either or both:

� Templates indicated by red document icons.

� Documents indicated by blue document icons.

A red template can be used many times, and creates a new blue document copy for you to work with 
each time you double-click on it.  A blue document is used to assemble a single document.

There are 4 expandable menu's listing these templates and documents:

� User Files Listing all of the (blue) documents you have created from a template or imported.

� JCT 05 Current Documents Listing all of the current JCT 05 base contract templates.

� JCT 98 Archive Documents Listing the archived JCT 98 contract templates. See Document 
Archive.

� JCT 05 Archive Documents Listing the archived JCT 05 contract templates. See Document 
Archive.

Underneath each of these 4 menus are listed the categories or Contract Families.  These may be 
expanded to reveal the templates or documents beneath.



Document Archive

Templates shown in your Briefcase might be listed under the JCT 98 Archive or the JCT 05 Archive.

In both cases, if you attempt to open a template listed in one of these archives, it will be read-only (i.e. 
it may not be edited or assembled).  In the case of the JCT 05 archive, the document will display a 
watermark of "Superseded" on all pages when printed.  In the case of the JCT 98 archive, this will 
open up the contract as a PDF document in Adobe Acrobat Reader™, and will display a watermark of 
"Archive Copy" on all pages.  You must therefore have this software installed in order to access the 98 
Archive.

The JCT 05 Archive will be automatically populated when you import a newer version of an existing 
template into your Briefcase.

If you wish to be sure that you will retain a previous version of the 05 contract for assembling/editing, 
you should save and retain a ‘clean’ version of the template in your User Files.



Using Rapidocs Document Properties

Document (or Template) properties are attributes for documents that are used to describe the 
document more fully.

You can access a document’s properties in any of the following ways:

� In the left-hand pane, select ‘Properties’ in the ‘Documents Tasks’ menu.

� In the Navigation Window, right click on your document and select ‘Document Properties’.

� For templates, this is listed as 'Base Contract Properties'.

In the case of blue documents, you may edit the Document Name property.  The other properties are 
purely for reference purposes.



Managing Document Access

The Network version of Rapidocs Classic+ contains several features to enable you to collaborate with 
fellow network users and share your documents with them. These are described below.

Show all standard documents

By default, only those document explicitly marked as "public" by other users will be available to all to 
view. This option enables you to view other users' documents marked as "standard" as well.

Mark as private

This enables you to mark the document as private to ensure that only you have the right to view or edit 
the document. You may toggle this by clicking it again to mark it as "standard". You may only carry out 
this action on documents assigned to you.

Mark as public

This enables you to mark the document as public allowing other users on the network to view or edit 
your document. You may toggle this by clicking it again to mark it as "standard". You may only carry 
out this action on documents assigned to you.

Clear edit lock

When a document is opened for editing, it is marked as locked so that no-one else can edit it. Clearing 
the edit lock overrides this protection, however it should be used with care to ensure that document 
version conflicts do not arise.

Assign ownership to someone else

This enables you to give ownership of the selected document to another user on the network. By 
clicking it you will be presented with a list of network users who you may assign the document to. You 
may only carry out this action on documents assigned to you.



Configure Rapidocs

This allows you to enter information that may provide default values to be used during assembly, or to 
configure certain aspects of the Rapidocs Classic+ application.  To access this feature click on 
'Configure Rapidocs' in the 'Other Tasks' panel in the bottom left.

The configuration window is split into four sections:

Personal Details

� This is where you can enter your personal details.  This information may be used to provide 
default answer values when assembling Rapidocs documents.

Preferences

� Checking or unchecking the three boxes has the following effects:

� Use popup explanation windows  By default, the explanation text for each question is 
shown in a popup immediately to the left of the question that is being answered.  Alternatively, 
by un-ticking this option, each explanation will appear in a panel on the bottom left of the 
assembly screen.

� Show popup hints for controls  By default the name of the toolbar button is displayed if the 
mouse is pointed at it.

� Flat toolbar buttons  By default each toolbar button appears in a box.  If you enable this 
option, the toolbar buttons will be shown without the surrounding boxes, giving them a flat 
appearance.  The box shape then only appears when you hover over the button.

Dialogues you have asked not to see again

� During Assembly hints and tips boxes may appear from time-to-time.  You can disable/enable 
these by checking/unchecking the appropriate box.



Deleting Documents

To delete a document:

� In your Briefcase, click on the document to select it.

� Either select ‘Delete this Document’ in the 'Document Tasks' list in the left-hand panel, or right 
click on the document and choose to delete it.

� Answer ‘Yes’ to the confirm prompt.



Search Documents

To search for a document or template containing a word or phrase:

� Click the Search Documents task.

� Enter the word or phrase in the search box.  Click 'Add'.

� If you wish to search for more than one word or phrase, enter another one and press 'Add' again.

� Repeat the process until all your words/phrases are listed.

� Select whether you would like the search to be a boolean AND or an OR type search (this is only 
relevant if you have mulitple search phrases).

� Press 'OK' to run the search.

The documents and templates returned from your search will be shown in your Briefcase.  All other 
documents will be hidden.

If you wish to clear the search, and restore your other documents/templates, use 'Clear Search' under 
the 'Other Tasks' menu.



Importing Documents

Rapidocs automatically imports documents from your 'Automatic Import Folders' into your Briefcase as 
soon as it is run.  When you do so, the "author" property of the document will be updated to the name 
of the current user of Rapidocs Classic+.

Import Documents

The ‘Import Documents’ option allows you to do one of three things:

� Search your hard disk for any Rapidocs documents that aren't in the Automatic Import Folders.  At 
the end of the process, if it finds any it will prompt you to import them, and will also add these 
folders to the list of Automatic Import Folders.

� Manually import a Rapidocs document from a folder of your choice.  This allows you to simply 
browse for a specific Rapidocs document in a folder and import it.

� Choose which folder Rapidocs should watch for new Rapidocs documents.  See Configure 
Automatic Import Folders.

It should be noted that Rapidocs automatically imports a document then that document will be deleted 
from the file location it was previously saved in. If, on the other hand, you manually import a document, 
then the document will also remain on file.

Importing Duplicate Documents

It is not possible to have two read-write versions of the same document in your briefcase.  Therefore if 
you attempt to import a duplicate document (i.e. one whose unique document identifier already exists 
in your briefcase) then you will be presented with three options:

� Overwrite existing document - This means that the existing document in your briefcase will be 
overwritten by the document you are importing, and any changes made in the existing one will be 
lost.

� Import new document as read-only - This means that the document you are importing will become 
read-only (see definition below) and your existing document is unaffected.

� Make existing document read-only and import new document - The means that the existing 
document becomes read-only and the document you are importing remains read-write.

If using the third option, it should be noted that the existing document which becomes read-only 
cannot be subsequently made read-write.

If more then one user shares a PC but logs in with their own user name they will still all share one 
briefcase. Each user will create their own files which will be saved under User Files but if e.g User A 
subsequently exports a document to file and User B then imports that file (choosing ‘overwrite existing 
document’) the file will disappear from User A’s user files.

NB As long as the user manually imported the document (see Import Documents, above), then the file 
will still be available in the folder, but it should be noted that if User A then chooses to import the file 
again User B will lose that file from his User Files.

Read-Only/Read Write

A read-only Rapidocs document is one which you are allowed to view and print, but you may not 
change any of the text using the Editor of any of the answers to any questions.

A read-write Rapidocs document is the more familiar type of document where you are permitted to 
change clauses of the document and answer, or change answers, to the questions.



Configure Automatic Import Folders

Rapidocs Classic+ contains a sophisticated search feature that will automatically watch user-specified 
folders for Rapidocs documents.  When a document appears in one of the watched folders, Rapidocs 
Classic+ will automatically import the document into your Briefcase.

If you wish to change or add to the list of folders Rapidocs should watch for new documents:

� Click on 'Import Documents' in the 'Other Tasks' panel.

� Select 'Choose which folders Rapidocs should watch for new documents'

� The ‘Scan Folders’ tab is displayed.  This is where you say where you want Rapidocs Classic+ to 
look.  The default setting is the user’s ‘Desktop’. 

� Insert the name of the required folder in the ‘Enter Folder Name To Scan’ box.  To select the 
folder, click on the dots to the right of this box to display the ‘Select a Folder’ window.  Make your 
selection and click ‘OK’.  Then click ‘Add’, which puts it in the list of directories to scan.

� Should you wish to delete a folder from the folders to be scanned, click on the appropriate folder 
name and click ‘Remove’.

� You can also modify any of the folder names by selecting it first, then editing it or browsing to a 
new location and clicking the ‘Replace’ button.

� Click ‘Save’.

At the top of the ‘Configure Automatic Import Folders’ window there is a tick box titled ‘Enable 
Automatic Import’ which is ticked by default.  Removing the tick will prevent the automatic import 
feature from running.

Excluding Files from the Automatic Import

Having told Rapidocs Classic+ to watch a certain folder for Rapidocs documents, you may wish to 
exclude certain files from the search.  To exclude files:

� Click on the ‘Exclude Files’ tab.

� To select the file, click on the dots to the right of the ‘Enter the File Name to exclude from 
automatic importation’ box. The ‘Select the file to exclude’ window is then displayed.

� Select the file and click ‘Open’.  Then click ‘Add’ which puts it in the list of files to exclude.  You 
can use wildcards to exclude multiple files if required.

� Click ‘Save’.

Rapidocs Classic+ will then ignore these files when the Automatic Import is being carried out.



Transferring Documents

Rapidocs Classic+ allows you to transfer documents so that other people can work with them.  There 
are two methods available to perform the transfer:

� By email

� Export it to a file



Sending by Email

This option allows you to send the selected document as an attachment to an email message.  

To transfer a document by email:

� Select the document you wish to send by highlighting it in the right-hand panel.

� Click on 'Email this document' in the 'Document Tasks' list.

� Enter the email address of the recipient of your document.

� Enter a message to be sent with your document (optional).

� Click 'OK'.

� If you're using MS Outlook, you may see two message boxes (see below) one after the other.  You 
will need to select 'Yes' to in both cases in order for your message to be sent.

 

Note: Sending by Email will only work if you have a MAPI compliant email client.  If you do not, you 
should Export the document to disk first, then open your email application and finally email it as an 
attachment.



Exporting to a File

You may wish to export a document to a file so that it can be transferred using other media such as a 
floppy disk, or to export multiple documents so that they can be attached to a single email message.

To export a document to a file:

� Select the document you wish to send by highlighting it in the right-hand panel.

� Click on 'Export this document' in the 'Document Tasks' list.

� Browse to the folder on your hard-drive you wish to export the document to.

� Click 'OK'.



Activity Report

The activity report may be run at any time and provides the following information on documents that 
have been printed:

� Date/Time of printing

� The Document name

� The number of Print Credits debited

� The username of the person who printed the document

If you select the 'Print' button to print the activity report, it will also display the computer name at the 
top of the printout.

You may reorder the report by clicking on the appropriate column heading accordingly.

Filtering the Activity Report

The filter allows you to show only the results that meet the desired criteria. Select the check box(es) to 
choose which fields to filter on and then choose the corresponding criteria.



Hidden Documents

To hide a template or document

Right click on the document or category to be hidden.
Select 'Hide this Document/Category' from the context menu.

To un-hide all of your hidden documents

Select 'Show Hidden Documents' from the 'Other Tasks' menu.
Uncheck the hidden documents from the list you wish to unhide.



Updates

Document Updates

From time to time new updates of the base contracts will become available. These will automatically 
appear in your list of contracts and older versions will be moved into the Archive.

Contracts may occasionally be discontinued - if this happens, a discontinued contract notice may 
appear in your archive along with the contract that has been discontinued.

If you have any questions or concerns about this, you should contact your local Rapidocs 
administrator.

Other Updates

From time to time new versions of the software will be issued. When this happens you will be sent an 
e-mail directing you to download that new version from the JCT website.



Assembling Documents

This section contains the following topics:

� Opening a Document

� The Assembly Screen

� Answering Questions

� Changing Answers

� Adding Looped Answers

� Annotating Answers

� Completing Assembly

� Alternate Views of Your Document

� Editing Your Document

� Saving Documents

� Accessing Document Notes

� Answer Summary

� Exporting/Importing Answers



Opening a Document

To create and open your document ready for assembly:

� To create a new document from a template: Click twice on the appropriate red template icon in 
your Briefcase.  This creates and opens a copy of the document, which is then ready to assemble.  
When saved, your new document will be signified in your Briefcase by a blue document icon.

� To open an existing document (containing previously stored answers and edits): Click twice on the 
blue document icon in your Briefcase.

You can switch at any time between the Navigation Window and any open documents by choosing the 
appropriate document name on the ‘Window’ menu.  The Navigation Window appears on the 
‘Window’ menu as ‘Rapidocs Classic+’.



The Assembly Screen

The main assembly screen shows the following:

� Live document text on the left (except in the case of Guides). 

� The question and answer panel on the right.

� Explanations of questions which will either be shown in a panel on the bottom left or as popups 
directly to the left of the relevant question.

You can choose whether to view your explanations as popups or in panels.  See Configuring Rapidocs
.

If the explanations are being displayed in panels, you can change the height of the document window 
by dragging the divider up or down. This is useful if you want to increase or reduce the amount of text 
displayed in the explanation panel at the bottom of the screen.



Answering Questions

As you answer the questions, you can see the document being updated on the screen. Once the 
contract is assembled, the answer is "tracked" i.e. shown underlined in the change-tracking colour 
assigned to you.

Note that any question may have a default answer.  A question may become greyed-out (i.e. you 
cannot input in it).  This means that Rapidocs has determined that you do not need to answer it.

A question may have a coloured dot to the left of it.  The following table explains the meaning of each 
different colour:

Dot Colour Denotes

No dot The question is not mandatory for printing a final version of the contract.

Black The question is required and has been answered.

Red with black 
border

The question requires an answer before the document 
can be printed as final version of the contract.  

Green triangle The question has a user annotation attached. See Annotating Answers. 

If there is more than one question on the page, you can move up and down by using tab and shift+tab, 
or by clicking in them. You can move on to the next page by pressing enter (unless in a multi-line text 
question) or by clicking ‘Next’.   

Any explanation for an individual question will either be displayed in the bottom left of the screen or as 
an explanation popup directly to the left of the question.  See Configuring Rapidocs.

Different coloured lines in the live document text panel on the left indicate the following:

Line Colour Denotes

Red An active data field; the line will disappear when the question and answer 
session is first completed, regardless of whether the question is answered.

Black Formatting line only.



Changing Answers

The answer is “tracked” ie. shown underlined in the change-tracking colour assigned to you. If you 
overwrite an answer in the document that a previous user gave, their answer will be struck through 
and your answer will take precedence.

If an answer is changed to leave the question blank after it has previously been answered by the 
original user, the default text (Not answered) in the Answer Summary will not be reinstated. All 
answers to questions, irrespective of whether the question is subsequently greyed-out, are stored in 
the answer summary. To clear these, you need to clear each answer individually.

If an answer is changed the application needs to be refreshed for the new answer to appear in the 
Answer Summary. Refreshing is achieved by clicking out of and back into the Answers view.

Answers to multiple choice questions are not generally tracked.  Answers are tracked if the question 
requires a typed answer such as a text or numeric answer.

Looped answers may also be tracked.  See Adding Looped Answers for more information here.



Adding Looped Answers

Certain groups of questions may be asked more than once, for example so that you can enter a list of 
entries.  Such groups of questions are known as 'Loops'.

Answering Looped Questions

When you first encounter a Loop an information box will alert you to this fact.  If you decide to proceed 
to answer the questions within the loop, you will see three options:

� Menu - This switches you into the loop menu where you can review the looped answers you've 
entered.  You should use this button when you've finished entering your looped answers.

� Back - This goes back to the previous entry, or if you're at the first entry then it takes you back to 
the screen before the loop.

� Add - This adds the answers you've given for this loop entry and presents a new set of blank 
questions for you to add the next entry if you wish.

The Loop Menu

When you press the 'Menu' button you'll be taken to the loop menu.  This displays a list of the entries 
you've given.  Select one of these entries and use the following buttons:

� Edit - Edits the selected loop entry to enable you to change the answers if required.

� Add - Enables you to add further looped answers after the ones already entered.

� Insert - Enables you to add further looped answers before the one currently selected.

� Delete - Deletes the looped entry currently selected.

� Menu - (If present) takes you to the final group menu of the whole document (not to be confused 
with the loop menu). See Completing Assembly.

� Back - Jumps back to the previous question group.

� Next - Jumps to the next question group.



Annotating Answers

You may wish to provide some notes to go with your answer.  This can be useful to record any special 
conditions that led to giving a particular answer, yet will not be required in the document.  To annotate 
your answer:

� Right-click on the appropriate answer and select ‘Annotate’.  

� Enter your text in the ‘Note’ window.  

� Click ‘OK’.

� Click 'Clear' to delete your annotation.

A triangle will then appear by the question to indicate that some notes are available.  If the question is 
mandatory for printing a final version of the contract and has not yet been answered, this triangle will 
be red, otherwise it will be green.

To read an existing annotation to a question simply repeat the above process to display the 'Note' 
window.

These notes appear in the Answer Summary view.



Completing Assembly

When you have answered all the questions, you will reach a menu that shows all of the question 
groups.  A group may have a dot next to it.  A red dot with a black border indicates that there are 
required questions in the group that still need to be answered before a final version of the contract can 
be printed.

Double-clicking on the group name will take you to the relevant group, enabling you to edit or complete 
your answers.  Alternatively you can click the ‘Back’ or ‘Edit’ buttons to go back through the questions.  
In either case you will be able to return to the menu screen by clicking on the ‘Menu’ button which then 
appears.

Clicking on the ‘Finish’ button takes you straight to a full screen view of the document with your 
answers inserted.  You may be granted permission to edit the text of your document in this view.  See 
Viewing or Editing Your Document.



Alternate Views of Your Document

You can switch at any time between the Assembly screen and Edit Mode screen of your document in 
any of the following ways:

� Choose ‘Assemble’ on the ‘File’ menu.

� Click on the ‘Assemble’ icon.

� Press F9.

You can only Print your document from the Edit Mode.



Editing Your Document

In most cases you will be able to edit your document using the powerful word processing features 
available in Rapidocs Classic+. These are described in full in the section on Editing Documents.

If you wish to edit an answer that has been inserted into the document, you should always use the 
'Assemble' button to move into the assembly screen.

It it possible to move to the assembly screen by a double click on an answer in Edit Mode, but this is 
not recommended.

Until a primary question is answered (e.g. whether Sections apply or not) associated questions will not 
be asked. If you subsequently deactivate a primary question, associated questions will grey-out or be 
hidden.

Note Any changes to, or deletions of answers should always be done in the 
Assembler rather than the Editor since this will ensure that the answers are 
stored correctly and also shown in the Answer summary.

Protected Text

Certain text (shown with a yellow background) is protected.  This means that it can not be edited, cut 
or deleted.



Saving Documents

Saving a document during assembly always creates a ‘blue’ document.  The first time you save a 
document, you will be asked to provide a name for your document.  See Using Rapidocs Document 
Properties.

Using ‘Save As’ creates another copy of the document for you, as it does in Microsoft Word.  ‘Save As’ 
always takes you to the Document Properties screen where you can view the properties.

To save your document:

� Click ‘Save’ on the toolbar or ‘Save As’ on the ‘File’ menu.  

� The first time you do this, the ‘Document Properties’ screen will be displayed, where information 
about the document is stored.

� You must provide a unique name in the ‘Document Name’ box.

� Click ‘OK’.

When saving, you are not asked for a location, since all documents are automatically saved in your 
Briefcase.  When you have closed the document, it will appear as a blue document in your Briefcase.



Accessing Document Notes

Where a Contract Guide exists the text will be displayed on the Notes tab. These notes could give 
important background information or simply provide an overview of the document.  To display the 
document notes, simple click on the 'Notes' tab on the left-hand side above the document pane.  They 
will be displayed in place of the document being assembled. To switch back to the document pane, 
click on the 'Document' tab.

These notes are not intended to be printed from this tab, but if printed as part of a contract file the 
Guide pages include headers, footers and covers from the contract, not the Guide. 

Clean versions of the Guides can be printed using the Guide template included in each Contract 
Family group in the JCT 05 Current Documents menu. 



JCT Amendments to Contracts

When published you can view the text of JCT amendments to contracts by clicking Amendments from 
the View menu. Here you will be able to see the actual text of each individual amendment. When an 
amendment has been published it will also be amalgamated into the appropriate JCT contract. The 
existing version of the contract will move to the Archive and the newer version will be imported into 
Current Documents. This will happen either when you receive the next release of the CD or more 
immediately if you are an online subscriber and decide to download the latest version available.



Answer Summary

A summary of the questions, answers, and any annotations for the document being assembled can be 
obtained by clicking 'Answers' from the 'View' menu. See also Changing Answers.

This lists the question in bold, the answer in normal font, and the annotation (if it exists) in italics.



Exporting/Importing Answers

You may export the answers from your document at any point using 'Export Answer File' from the 'File' 
menu or clicking on the appropriate icon in the toolbar.  Answer files are stored in .xml format and may 
be saved on your local disk.

To import answers into your document, use 'Import Answer File' from the 'File' menu or the toolbar 
icon.  You may then browse for the file to import answers from.  You will be prompted to overwrite your 
existing answers if you wish.

Importing Answers is a useful way of reusing a standard set of answers providing that the contract 
template you are importing into matches the contract template you exported from, e.g. MW to MW. 
This feature will not work across different contract templates, e.g. MW to MWD.



Introduction to Editing Documents

This section contains the following topics:

� The Editing Toolbar

� Cut, Copy and Paste

� Find and Replace

� Bookmarks

� Spell Check

� Using Tables

� Table of Contents

� Footnotes

� Inserting Special Characters

� Tracking Changes Made to a Document

� User Revisions

� Clause Library

� Printing Documents

� Keyboard Shortcuts



The Editing Toolbar

The formatting toolbar gives you access to common format features.  The name of a toolbar button 
will be displayed when you point at it with the mouse.  See Keyboard Shortcuts for the shortcuts to 
these features.  

Bold, Italic, Underline, Strikethrough

Text may be made bold, italic, underlined, or struckthrough by selecting the text and pressing one or 
more of these buttons.  Note: You may only change the formatting of text that has been inserted by 
yourself or another user, i.e. original text from the template may not be changed in this way.

Export/Import Answers

Answers can be exported or imported by using the two buttons shown in the toolbar. See 
Exporting/Importing Answers for more information.

Left/Right align, Centre, Justify

A paragraph of text may be aligned, centred or justified by placing the cursor in the desired paragraph 
and using one of these buttons.  Note: You may only change the alignment of paragraphs that were 
wholy created by yourself or another user.  The alignment of paragraphs containing any original text 
may not be changed.

User Revisions

The following icon  enables you to access the User Revisions for your document.



Cut, Copy and Paste

Some Rapidocs features may only be used if the author has allowed you to.  See Viewing or Editing 
Your Document for more information.

You can paste text from Microsoft Office documents into Rapidocs Classic+. You can not copy or cut 
text from within the JCT document.

If you wish to paste text from the clipboard without the accompanying styles and formatting, you 
should use 'Paste Flat' from the 'Edit' menu.

Paragraph Marker

When copying from a Microsoft Office document, the paragraph marker appears as a space at the 
end of a paragraph when you are selecting text. It is important to select it if you want Rapidocs 
Classic+ to keep the style of the paragraph when you paste it. 

If a selection goes across a paragraph boundary the paragraph marker will be selected automatically.  
Alternatively you can use Shift and the left or right arrows to extend the selection to include the current 
paragraph marker.  For example, use Shift+End to select to the end of the current paragraph, then 
use Shift+Right Arrow to add the paragraph marker to the selection.

Protected Text

Certain text (shown with a yellow background) is protected.  This means that it can not be edited, cut 
or deleted.



Finding Text

This tool allows you to search for specific text in a document.  It is enabled by clicking ‘Find’ on the 
‘Edit’ menu or by using the keyboard shortcut Ctrl+F.  This displays the ‘Find’ tab of the ‘Find and 
Replace’ window.  Note that the ‘Replace’ tab is only available if you have permission to edit. 

� Type the text that you want to search for in the ‘Find what’ box at the top of the window. Clicking 
on the arrow on the right of the box allows you to see the most recent search requests and choose 
one of them if you wish. 

� You can search for special characters and fields by clicking on the ‘Special’ pull-down menu and 
making your selection from the list, such as ‘Any letter’, ‘Hyperlink’, ‘Question/Field’ etc.  The 
appropriate abbreviation will then be inserted into the ‘Find what’ box. If you're searching for a 
clause number, you should use the midpoint character (for example, when searching for clause 
number 4·2).

� By default, Rapidocs will ignore the case of the text you enter.  If you would prefer the case not to 
be ignored, tick the ‘Case sensitive’ box.

� By default, Rapidocs will search for the text you type in whether it is part of a word or a complete 
word.  If you wish the search to only apply to complete words, tick the ‘Whole words only’ box.  
Clicking the ‘Find in fields’ box will apply the search to include the parts of the document 
containing answers you have supplied whilst assembling the document.

� Click the ‘Find’ button to carry out the search.

� If the text was not found, you will see a message ‘End of document - word not found’

� To close the ‘Find’ window, click ‘Close’.

� If the text was found, the first instance of your search following the current cursor position will be 
highlighted in the text.

� Click the ‘Find’ button again and the next instance of the search text will be highlighted.

� Continuing to click the ‘Find’ button will take you to every instance of the search text.  When every 
instance has been found, you will see the message ‘End of document - find complete’.

Note If you want to restrict the area of text upon which to carry out your search to a 
certain section, simply highlight the section in question before performing 'Find'



Replacing Text

This tool allows you to search for specific text in your document and replace it with other text.  Note 
that this tool is only available if you are allowed to edit the document.  It is enabled by clicking 
‘Replace’ on the ‘Edit’ menu or by using the keyboard shortcut Ctrl+H.  This displays the ‘Replace’ part 
of the ‘Find and Replace’ window.  Note that you can conveniently switch between ‘Find’ and ‘Replace’ 
by clicking on the appropriate tab.  Note also, as with 'Find' you can restrict the area of text to a 
user-selection.

� Type the text that you want to search for in the ‘Find what’ box.  Clicking on the arrow to the right 
of this box allows you to see the most recent ‘Find’ requests and choose one of them if you wish.  

� You can search for special characters and fields by clicking on the ‘Special’ pull-down menu and 
making your selection from the list, such as ‘Any letter’, ‘Hyperlink’, ‘Question/Field’ etc.  The 
appropriate abbreviation will then be inserted into the ‘Find what’ box.

� By default, Rapidocs will ignore the case of the text you enter.  If you would prefer the case not to 
be ignored, tick the ‘Case sensitive’ box.

� By default, Rapidocs will search for the text you type in whether it is part of a word or a complete 
word.  If you wish the search to apply only to complete words, tick the ‘Whole words only’ box.  

� In the ‘Replace with’ box, type the text with which you would like to replace the text you are 
searching for.  Clicking on the arrow to the right of this box allows you to see the most recent 
‘Replace’ requests and choose one of them if you wish. 

� Click ‘Find’.  Note that ‘Replace’ and ‘Replace all’ are disabled until the first instance of the text is 
found and highlighted.

� If the text was not found, you will see a message ‘End of document - word not found’.

� If the text was found, the first instance of your search following the current cursor position will be 
highlighted in the text.

� You can replace a single instance, selected instances or all instances of the text.

� To replace a single instance, click ‘Replace’.  You will not be able to replace protected (yellow) 
text.

� To replace specific instances, continue to click on the ‘Replace’ button only on those you wish to 
replace.  If you find an instance you don’t want to replace, simply click on the ‘Find’ button again to 
go to the next instance.

� To replace all remaining instances, click ‘Replace all’.

� When the replace is complete, you will see the message ‘End of document - Find complete’.



Bookmarks

In a long document, it is often useful to be able to bookmark certain clauses to be revisited at a later 
date.  This is done using Document Markers.

Once you have located the clause you wish to mark, place the cursor at the end of the paragraph or 
sentence and choose ‘Tools’, ‘Insert’, ‘Marker’.  You may do this for as many clauses as you wish.

To find your bookmarks in future, use ‘Tools’ and ‘Goto Next Bookmark’.  This will take you to the 
places in the document where your markers were set.

Markers can be deleted by highlighting the area where the marker was set and pressing delete.



Spell-Checking

The spell-checking tool may be found by selecting ‘Spell Check’ on the ‘Tools’ menu, or by pressing 
‘F7’.

� If a word is found that is misspelt or not recognised, the word will be displayed in the ‘Not in 
dictionary’ box. In the ‘Suggestions’ box, alternative spelling suggestions may be displayed.

� If you do not wish to replace the word reported as misspelt, click ‘Ignore’, or ‘Ignore All’ if there is 
more than one instance of the word in your document. 

� To replace the word with one of the suggested spellings, simply click on your chosen spelling in 
the ‘Suggestions’ box, then click ‘Change’, to change one instance, or ‘Change All’, to change all 
instances in your document. 

� You can also replace the word with a spelling of your own. To do this, type the new spelling in the 
‘Change to’ box, then click ‘Change’ or ‘Change All’.



Using Tables and Inserting Clauses

Rapidocs Classic+ allows you to insert and delete rows in existing tables. You can use this 
functionality to position new clauses.

To insert a row:

� Click in the row below where you wish your new row to appear.

� Select ‘Table’ on the ‘Tools’ menu, then ‘Row Insert’ via the right arrow.

To add a row:

� Click in the row above where you wish your new row to appear.

� Select ‘Table’ on the ‘Tools’ menu, then ‘Row Append’ via the right arrow.

To delete a row:

� Click in the row you wish to delete.

� Select ‘Table’ on the ‘Tools’ menu, then ‘Row Delete’ via the right arrow.

Note 1 You can not delete rows of the table that were inserted in the original template. 
You can delete rows that you or another user have subsequently inserted or 
added.

Note 2 If you delete a row with text in you will not be able to recover that text.



Table of Contents

A table of contents, listing headings and clause numbers, may have been inserted at the beginning of 
the document.  This is protected such that the entries cannot be edited.

You may double click on an entry in the Table of Contents list to jump to that section of the document.



Footnotes

References to footnotes are inserted in the document as superscript text.  Hovering over a footnote 
reference will display the footnote associate with it in a small box next to the cursor.

All the footnotes are listed in the 'Footnote Editor' at the bottom of the screen.  The footnote editor may 
be hidden or shown by using ‘Tools’, ‘Show footnotes’.  Furthermore, clicking on the reference itself 
takes you directly to the associated footnote in the footnote editor.  To disable this feature, use the 
'Auto-show footnotes' toggle from the 'Tools' menu.

In Rapidocs Classic+ you may not edit the footnotes in the editor.

If text that has a footnote attached is removed from the document (e.g. as a consequence of an 
answer to a question) that footnote will be removed. Footnotes will not be renumbered.

If text with a footnote attached is struck through that footnote text will also be struck through. If it has 
not been struck through it is because there is another reference to the footnote in the document.



Inserting Special Characters

Rapidocs Classic+ allows you to insert a symbol or accented character that is not available on the 
keyboard.

To insert a special character:

� Place your cursor in the position you want your special character to appear.  

� On the ‘Tools’ menu, select ‘Insert’ then ‘Special Character’. This displays the ‘Insert Special 
Character’ window, with two tabs ‘Symbols’ and ‘Accents’. 

� Select the character you require from the appropriate tab, and click ‘Insert’.



Tracking Changes Made to a Document

Tracking changes

Rapidocs tracks changes made to a document.  All text that is deleted is shown as struckthrough, and 
all added text is displayed as underlined in the change-track colour associated with the current user.

You should note that in some instances where text is removed as a consequence of answering a 
question (known as 'Conditional Text'), that text will not be tracked. Additionally, deletions/additions of 
table rows (see Using Tables) and deletions/additions of groups of questions as part of a Loop will not 
be tracked (individual questions answered within a loop are tracked however). You will also note that 
where there is a cross reference to a clause, then tracking will not adopt the colour of the individual 
users changes but will always be shown in black.

If you select 'Track Changes' from the 'Tools' menu, you can click on different users in the document 
history to ascertain which colour is associated with which users changes.

Rejecting changes

With certain struckthrough text, you may be entitled to reject the change (i.e. reinstate the original text 
without it being struckthrough), but only if the text was from the original template, not text subsequently 
added by another user.  This is done by right-clicking on the change you wish to reject, and choosing 
'Reject change' from the menu.

If text has been struckthrough by selecting the text and using 'Delete', then generally speaking, 
rejecting the change here will reinstate all of the struckthrough text.  If, on the other hand, the text has 
been struckthrough by simply using 'Backspace', then changes will need to be rejected a "bite at a 
time".

If a clause is struckthrough and contains cross-references or answers to questions, then if you choose 
to reject the struckthough text, it will reject individual sections of the text separated by the 
cross-reference/answer.  If you wish to reject all of these changes, you will need to right-click on each 
part of the clause and reject the changes one at a time.



User Revisions

If you select the 'Show User Revisions' button in the toolbar, this will open up a separate window 
showing which clauses have been amended from the original template according to clause number. It 
also lists whether text has been deleted, added or amended.
This report may be printed by selecting the print button.  This operates in much the same way as 
printing the main document - see Printing Documents for more information.



Clause Library

The Clause Library is for building up a library of new user inserted clauses and unamended JCT 
clauses so that they can be used subsequently.

The Clause Library Panel

To enable the clause library panel use ‘Edit’ and ‘Show Library’.  This will display the panel docked on 
the right-hand side of the Rapidocs window.  It is possible to un-dock this window if desired by simply 
clicking on the panel bar and dragging it to the preferred location.  It can be re-docked by dragging it 
back to the right-hand edge of the Rapidocs window.

Using the Clause Library

To ‘clip’ a clause to the library, simply highlight the clause or sentence you wish to store, then use 
‘Edit’, ‘Clip to Library’.  The clause will appear in the list of recent items and all items.  ‘Recent items’ 
shows the three most recently clipped clauses, and ‘All items’ shows all clauses in alphabetical order.

To find a clause from those previously clipped to the library, either scroll through the clauses shown in 
the panel, or alternatively, use the search box to find a word or phrase in the clause you’re looking for.

When you have found the clause you wish to insert into your document, simply highlight it, right click, 
and choose ‘Paste’.  This will paste the clause in wherever the cursor is currently located.

To delete a clause from the library, highlight it, right click, and choose ‘Delete’.



Printing Documents

To print a document, select ‘Print’ on the ‘File’ menu.  You may only print the document in Edit mode, 
not whilst Assembling the document.

Print in Draft

A document will be printed in draft format if you choose to print before you have answered all of the 
mandatory questions for printing the final version of the contract, or you decide to print the document 
without debiting the print credits required.  This will print the document with a watermark of 'DRAFT' on 
all pages.  The document will also print in draft if you have answered all of the questions yet have 
insufficient print-credits.

You can choose to print the whole document or a selected page range in draft.

Final print

When all the questions are answered and the document has been saved you may choose to print your 
document in its final format.  This will prompt you to debit the number of print credits required for that 
document, assuming you have sufficient.  It will then lock the document so that it may not be changed 
in future and renames your file to be of the format "filename (as printed dd/mm/yyyy hh:mm:ss)".  A 
duplicate (read-write) copy of the document is also generated so that you can go back to make further 
changes to the contract should you wish to in future.

If you choose to print multiple copies of the contract in final mode then the cost in print-credits will be 
correspondingly multiplied. You cannot print a selected page range when printing the document as 
final.

Front and back covers print at the end of the document.

Note The contents pages and covers are not included in the selected page range 
option.



Print Preview

Click the ‘Preview’ button in the Print dialog box to view your document before printing it. It is currently 
not possible to Print Preview a clean version of the final contract prior to printing. This feature will be 
incorporated into the next RC+ release.

Note that the entire document will be shown in Preview mode, even if you have specified a particular 
page range for the print itself.  The ‘Print Preview’ window is described below.

The toolbar at the top of ‘Print Preview’ gives you the following options:

Close Closes ‘Preview’ and takes you back to the document. 

Print Takes you back to the print options window.

Page Setup Takes you to the ‘Page Setup’ window, allowing you to edit headers and footers, and 
margins.

Left and right arrows Allows you to move backwards and forwards through the pages of the 
document.  The double left and right arrows take you to the first and last pages of the document.

Zoom Allows you to view a larger or smaller area of the document by clicking on the up or down 
arrows.

Full size Returns the document to its normal size of 100%.

Fit to window Zooms the whole page to fit in the current window.

Document Allows you to switch between the various components of your document using the down 
arrow.



Keyboard Shortcuts

Rapidocs has many keyboard shortcuts built in to the application for efficiency.  Regular users of the 
software will find these shortcuts an invaluable productivity aid.

When using a shortcut, note the conventions used below. For example, ‘Ctrl+F’ means that you hold 
down the key normally labelled ‘Ctrl’ on your keyboard, and press the letter ‘F’.

In some cases the shortcut may only be enabled in certain parts of the Rapidocs application.  
Restrictions are indicated where appropriate.

Familiar Microsoft Windows keyboard conventions are normally supported within Rapidocs.

Basic Assembly Features

Alt+N Go to Next question group.

Alt+B Go Back to previous question group.

Alt+F Finish the assembly questions.

Alt+M Go to the group menu.

Loop Features

Alt+Y Answer 'Yes' to enter a Loop.

Alt+N Answer 'No' to decline a Loop.

Alt+A Add a loop entry.

Alt+M Go to the loop menu.

Alt+E Edit a loop entry.

Alt+I Insert a loop entry.

Alt+D Delete a loop entry.

Editing Features

Ctrl+A Select all

Ctrl+C Copy selection to clipboard

Ctrl+V Paste from clipboard

Ctrl+Alt+V Paste Flat from clipboard

Ctrl+X Cut selection to clipboard

Ctrl+B Toggle bold mode

Ctrl+U Toggle underline mode

Ctrl+I Toggle italic mode

Ctrl+L Left align current paragraph

Ctrl+E Centre align the current or selected paragraphs

Ctrl+R Right align current paragraph

Ctrl+Space Removes any paragraph style overrides for the current paragraph, and any 
character overrides for selected text

Ctrl+F Find text

Ctrl+H Replace text

Ctrl+P Display print window

Ctrl+N Display new document window

Ctrl+S Save current document



Ctrl+Shift+G Goto next bookmark

Function Keys Activates

F1 User guide window

F4 Format style window

F5 Track changes dialog box

F7 Spell check

F9 Switch between assembly screen and document

Ctrl+F4 Close edit form

Shift+F4 Styles pull-down menu


